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Know Before You Use  
Phone keypad description  
Power button (on \ off button): The bond length for the switch by machine; in the call or the caller interface 

Click button to hang up; Click button on any interface can be a direct return to the standby interface.  

Side button: standby interface can be realized quickly adjust the function of the size of ring volume; in tone 

or MP3 player interface that enables adjustment  , ringtone volume size or the size of features    

Rackball: You can use the trackball to navigate the various interfaces. 

Battery installation / removal  
Exchange the battery, make sure you have closed the phone, at the same time disconnected from the 

charger links.  

SIM card installation / removal  

Installation, make sure you have closed the phone and remove the battery.  

If you do not properly insert the SIM card can only use the device in offline mode.  

T card installation / removal  

Installation, make sure you have closed the phone and remove the battery.  

Mobile Phone Charger  

In the charge before, make sure the battery has been correctly loaded mobile phones, and make sure the 

use of compatible charger.  

1. will be compatible with cell phone charger jack into the port.  

2. Connect the charger plug into the power socket on the device screen shows the battery charging icon 

was rolling.  

3. If the battery is completely depleted or long-term unused lead to the battery voltage is too low, 

charging, you may need to wait some time before a charge screen.  

4. Charging is complete, charge prompt the state to stop at full grid at this time, please disconnect the 

charger and the device link, and then unplug the charger from the electrical outlet.  

5. Please completely exhausted after the first fully charged before use, so easy to achieve the best use of 

the battery condition.  

Note: While charging, the circuit in order to avoid serious burning mobile phone, do not move or remove 

the battery.  

       Users not in a closed environment or in flammable and explosive environment charge.  

On / Off  

1, long press the power button to open or close the phone.  

2, if asked to enter mobile phone boot password, please enter the correct number, then select "Confirm", 

mobile phones default density  

Code is "1122."  

Input Method Description  

In the input interface, you can enter numbers, words or symbols, and more.  

1, switching input method: enter the editing interface, the options menu select the input method into the 

input method list, and press OK key to select the desired input method, your cell phone to provide you 

with pinyin input, strokes input, uppercase English, lowercase English, digital input , punctuation input in 

the six input; also available on the editing interface, click the interface in the input region to switch input 

methods.  

2, Pinyin input method: Click on the letter keys input alphabet, and then click on the text you want can be.  

3, stroke input method: Click the needs of stroke, and then click on the text you want can be.  



4, English case input method: Click the letter you need direct input.  

5, digital input method: Click on the number you need direct input.  

6, punctuation: In the punctuation list, click on the symbol you need a direct input.  

Menus  
1. Telephone Directory  

1.1 Quick Find  

Click on a telephone book entry, which indicates that phone book browsing interface, the bottom of the 

window provides a search input box, you can enter the appropriate information to the telephone records 

of screening, select a record, enter the option, the menu is as follows:  

1.1.1 View: See this article for details.  

1.1.2 Send SMS: send SMS to this number.  

1.1.3 to send MMS: Send MMS to this number.  

1.1.4 Call: Call the current number.  

1.1.5 IP Call: call this number to IP.  

1.1.6 Edit: Edit this article entry.  

1.1.7 Delete: delete the clause entry.  

1.1.8 Copy: Copy this article entry.  

1.1.9 Mobile: Mobile this article entry.  

1.1.10 Send Contact Person:  

1, text messages: Use SMS to send this article entry.  

2, MMS: Using MMS for sending this article.  

3, e-mail: Use e-mail this article entry.  

4, through Bluetooth: using Bluetooth to send this article entry.  

1.1.11 added to the blacklist: this article added to the blacklist, the other party could not inbound.  

1.1.12 Caller Group: This mobile phone to provide you with five caller groups, you can for each group to 

group members, change the name, ring type, caller personalized picture settings.  

1.1.13 Phone book settings:  

1, the preferred storage location: You can set the preferred storage location for the SIM card 1, SIM card 

2, mobile phone or all of the.  

2, speed dial: set the quick dial, dial interface, click on the corresponding number keys can be set by 

calling the telephone number.  

3, my numbers: numbers may be edited or send a  

4, business card version: You can set the card version 2.1 or 3.0.  

5 other numbers: You can right SIM card numbers to view the native and modified.  

* Note: The SIM card needs to support service numbers.  

6, storage condition: View the current storage state.  

7, copy contact: For cell phone or SIM card to copy all the records.  

8, mobile Contact: For cell phone or SIM card to move all the records.  

9, delete all of the contacts: the mobile phone or SIM card to delete all records.  

1.2 Add a Contact  

To add a new telephone directory telephone records, you can select stored way SIM card 1, SIM card 

two or cell phone.  

* Note: the two slightly different way in the storage.  

2. Information  



2.1 Write Message  

Into the editing interface for editing text messaging, SMS, content editing is completed by entering the 

following menu options:  

2.1.1, send: send this message, select the Add a recipient to enter the menu, you can directly enter the 

number or  

Select the number from the telephone book to add to send.  

2.1.2, Input Method: Select the required input method.  

2.1.3, insert a template: Select the contents of the template inserted into the editorial content.  

2.1.4, Advanced Options:  

   Insert object: you can insert pictures, animations and sound files.  

   Insert number: can be inserted in the phone book phone numbers to text messages.  

   Insert Name: the name can be inserted in the phone book to the text message.  

           Insert a bookmark: You can insert the URL.  

         Text format: You can right text size, font, alignment, set the paragraph.  

2.1.5, save it to Drafts: The editorial content directly saved to the Drafts.  

* Note: Some cities and regions of the short message center do not support more than 70 characters or 

more than 160 English characters), the length of the message.  

2.2 Inbox  

Showing SIM card and SIM card one inbox inbox 2, respectively, view the received message, in the 

event of a short message inbox list, you can press OK to read the message details.  

2.3 Drafts  

After the message if you do not send the editors choose to save, save here.  

2.4 Outbox  

Showing SIM card and an Outbox Outbox SIM card 2, view sent successfully or not to send a successful 

message. Outbox appears short message list, you can press OK to read the message details.  

2.5 MMS  

Include text, graphics and sound content. Via multimedia messaging (MMS) service (Multimedia 

Messaging Service, MMS), you can not only send or receive images and text, you can also receive 

information accompanying sound files.  

Phone supports multi-page MMS, that is, the content of each page contains a picture, a music, and text 

content, while multimedia message contains pictures, phone will automatically adjust the picture zoom, 

display the phone screen.  

* Note: This feature requires network operators support.  

2.5.1 Write Message  

Into the set-up message in the multimedia message, a new one MMS, you can fill in the recipient, Cc, 

Bcc, themes, MMS content and accessories.  

2.5.2 Inbox  

View the received MMS. (To do the same text message in the inbox.)  

2.5.3 Outbox  

Send successful or unsuccessful store to send multimedia messages.  

2.5.4 Draft  

After the message editor can be saved if you do not send here.  

2.5.5 Template  

There information can be selected by default, but also save the information for the custom.  



2.5.6 MMS settings  

To send and receive multimedia messages to set the relevant parameters.  

* Note: In the settings file must be set the correct parameters, or download the MMS failed.  

2.6 E-mail  

This feature requires network support, the initial need to enter e-mail account to use the menu to set 

mailbox accounts.  

Create a new account:  

A, enter the correct e-mail account name, the options menu to enter the next step;  

B, communication protocols: Select POP3 or IMAP4 (POP3 (Post Office Protocol 3) or Post Office 

Protocol version 3, which specifies how a personal computer connected to the Internet, mail server and 

download e-mail e-agreements; IMAP4 (Internet Message Access Protocol 4) or Internet Message 

Access Protocol version 4 of the first, is used to access e-mail from a remote server, the standard 

protocol; the difference please refer to the professional information) Options menu to enter the next step;  

C, Data Account: Options menu, select Always ask for editing in each use is to ask a choice SIM1, SIM2 

or wireless local area network, in which choice SIM1, SIM2 need to select the specific data account, 

GSM data or GPRS (need to Open GPRS service), and choosing the right operator (such as: china 

mobile gprs (China Telecom), china Unicom gprs (China Unicom)), the Options menu to enter the next 

step;  

D, the receiving server: Depending on your set up e-mail account to set up the receiving server (such as 

× × × @ qq.com is set to: pop3.qq.com or imap.qq.com and communication protocol setting corresponds 

to), Options menu to enter the next step;  

E, the sending server: According to the mail account settings, outgoing server (such as × × × @ qq.com 

generally set to: smtp.qq.com), the Options menu to enter the next step;  

F, user name: Edit the user name, the options menu to enter the next step;  

G, password: password, options menu to enter the next step;  

H, Account name: set up an account name, enter the completion of the Options menu to complete the 

account settings.  

E-mail account settings is complete you can send and receive, edit, e-mail, Inbox, Outbox, Sent Items, 

Drafts, empty e-mail and other operations.  

1, send and receive: A Good-mail account has been set up to send and receive operation.  

2, edit the e-mail: Editor e-mail.  

3, Inbox: See receive e-mail.  

4, Outbox: View sent messages unsuccessful.  

5, Sent Mail: View Sent Mail.  

6, Draft: Editor If you do not send a good message can be stored here.  

7, empty-mail: select all clear or all of the empty mailbox.  

8, delete marked e-mail: The delete operation marks a good e-mail.  

9, e-mail account: set up an e-mail accounts, accounts can be right there to start, edit, delete operations.  

10, the template: It is the default e-mail content can be selected, but also save the information for the 

custom.  

2.7 Cell Broadcast  

SIM cards can enter a cell broadcast can also choose to enter the SIM card 2 Cell Broadcast. Cell 

broadcast receiving and reading the news of the following functions:  

2.7.1 Receive Mode: on or off Cell Broadcast.  



2.7.2 read the information: Read Cell Broadcast has been received.  

2.7.3 Language: Select language.  

2.7.4 Channel Settings: Cell Broadcast Channel settings. Including the selection, add, edit and delete.  

2.19 Template  

Information can be used to write some commonly used sentences in order to avoid sending duplicate 

messages one by one, when typing, can be edited or deleted.  

2.9 SMS Settings  

Using the short message function of time, you will first need to do the necessary settings.  

2.9.1, the pattern is set: to provide four modes for you to set up, you can set the mode name, SMS center 

number, SMS is valid, send format.  

2.9.2, voice mail: You can enter the SIM card a voice mail, you can also choose to enter SIM card two 

voice mail. Any voice mail, you can edit the voice mail on a call or edited.  

2.9.3, status settings: open or closed to send a report, open or close the reply path, open or close the 

save sent messages  

2.9.4, memory status: See mobile phones and SIM card memory status.  

2.9.5, the preferred storage location: can be set to SIM card or mobile phone.  

3. Call Center  

3.1 Call History  

Chose to enter call history menu, there is a phone SIM card records and phone records of two SIM cards 

two options, either a call record is as follows:  

3.1.1, did not answer the phone: a record of 20 missed in different phone numbers.  

3.1.2, has been making telephone calls: a record of 20 has been allocated a different phone number.  

3.1.3, has to answer the phone: a record 20 different phone numbers have been received.  

In the call history list interface, press OK to view the record details, including date, time of call, name (if 

the phone book there this record), number, and dial the number.  

In the details interface, you can click Options on the currently selected phone records do the following.  

1. Delete: Delete this record.  

2. Save to Phonebook: this number stored in the SIM card or mobile phone.  

3. Call: Call the telephone number.  

4. Editor: Edit the phone number and phone book of the deposit.  

5. Send SMS: send SMS to this number.  

6. To send MMS: Send MMS to the number of  

3.1.4, delete the call records: choose Empty the list of records to a call.  

3.1.5, call timing: In the talk time, there are four sub-menu: At the last call, dialed calls, received calls and 

reset all.  

1, last call: Check out the last time talk time.  

Two have since been donated Phone: view the total time allocated telephone.  

3, has to answer the phone: view the total time to answer the phone.  

4, Reset All: All calls time zero.  

3.1.6, call billing: Call costs can be accumulated for you to store phone billing.  

1, the last call cost: Check out the last time call charges.  

2, all call costs: See the accumulated call charges.  

3, reset call cost: Enter PIN2 code may be cleared on the meter and re-start accounting.  

4, cost restrictions: limit the cost to enter sub-menu, you can view, modify or cancel the feature. 



Amendment and cancellation of these functions need to enter the PIN2 code.  

5, prices and rates: Call rates to enter sub-menu, you can browse, modify or cancel the feature. 

Amendment and cancellation of these functions need to enter the PIN2 code.  

Note: Some operations require that you enter the PIN2 code, contact your network vendor to obtain the 

password.  

* Note: the need for network support  

3.1.7, SMS Counter  

Sent: Record the number of sent SMS.  

Have been received: Record the number of messages have been received.  

The left soft key "Reset" to clear these two, respectively.  

3.1.8, GPRS Traffic  

Last delivery: Record the last number of bytes transmitted.  

Last received: Record the last number of bytes received.  

Total sent: Record total number of bytes transferred.  

Total received: Record total number of bytes received.  

Reset Counter: re-start counting.  

3.2 Phone Setting  

3.2.1 Call Settings  

SIM card is displayed as a call to set up and SIM cards 2 call set up.  

1, the machine number:  

The system default: number of sending or not using the system default.  

Hide number: call when the other party do not see numbers. (Requires carrier support)  

Send number: call when the other party can see the numbers.  

2, call waiting: the call waiting feature on or off. Select query to view the current status of call waiting.  

3, call forwarding:  

Forwarding all voice calls: Turn on forwarding all voice calls, will in any case the phone call to set up the 

transfer to your number.  

Contact less than a transfer: the transfer can not open the contact, it will not contact you in the other case, 

shall be credited to set up calls to your number.  

No Answer Transfer: Turn on the transfer of non-response, will be on your cell phone number does not 

answer case, will be paid calls to the number you set.  

Busy Transfer: Open the busy transfer, will be on your phone is busy, it will be transferred to the dial 

telephone number you set.  

Relay all data calls: When to open relay all the data calls, will be credited to all the calls to the number 

you set.  

To cancel the transfer: cancel all call forwarding.  

4, call restrictions: restrictions on phone calls.  

Prohibition set aside: To restrict outgoing calls.  

Prohibition of calls: The calls to restrict.  

Start All: Start all the settings restrictions.  

The abolition of all: the abolition of the restrictions set in (required to enter the PIN2 code).  

Change Password: Change Password.  

5, line switch: Select line 1 or line 2.  

Note: This feature requires SIM card where the network operator support.  



3.2.2 Advanced Settings  

1, blacklist: You can edit the blacklist numbers, and the mode setting is turned on or off, black list 

numbers will be rejected in the number of connected.  

* Note: Please enter the region fixed-line telephone number  

2, automatic redialing: Open the automatic redial after the failure of each call will be automatically redial.  

3, IP Dial-up: You can set the IP dial-up.  

4, the background sound: You can set the background sound when making a call.  

5, Call duration display: you can set whether to display talk time.  

6, talk time tips: You can set whether to prompt, suggesting that cycle, and whether repeated prompts.  

7, automatic time limit: set talk time, when the time is, the phone automatically hang up.  

4. Set  

4.1 Mode Setting  

4.1.1 Dual-Mode Open: Turn dual card dual standby.  

4.1.2 Only an open SIM card: SIM card one standby.  

4.1.3 Only two open SIM card: SIM card two standby.  

4.1.4 Flight Mode: Turn on flight mode, so that no cell phone service into the state.  

4.2 touch screen calibration  

    Click the icon interface, the center of the screen calibration.  

4.3 Phone Settings  

4.3.1 Time and Date: Set the time and date.  

1, set the City: The phone number of different cities around the world collected for you to choose.  

2, time / date settings: set the current time and date.  

3, the format settings: set the time format to 12-hour or 24 hour clock.  

4.3.2 Timing Switch Machine: Set the time period in the boot or shut down.  

4.3.3 Language: set the phone menu display language.  

4.3.4 the preferred input method: Choose a default input method.  

4.3.5 Caller attribution display: Set Caller attribution to display on or off.  

4.3.6 Key vibration settings: Settings button vibration turned on or off.  

4.3.7 touch screen vibration settings: set the touch screen vibration turned on or off.  

4.3.8 encoding: set encoding to Big5 or GB2312.  

4.3.9 Standby menu displays:  

1, Wallpaper: Select standby interface wallpaper.  

2, boot Animation: In order to boot select an animation.  

3, shutdown animation: an animation for the shutdown option.  

4, the screen switching effect: on or off the screen transitions.  

4.3.10 greeting: Set to open, you can edit the boot display greeting.  

4.3.11 Automatic Update: Automatic Updates turned on or off time function.  

4.3.12 handwritten settings: Set the speed and handwriting handwritten pen color displayed when editing 

the contents of a handwritten set the display.  

4.3.13 UART settings: SIM card can be set to 1 or SIM card 2.  

4.3.14 Other settings:  

LCD backlight: Set up the phone LCD backlight brightness and time.  

4.4 SMS Settings  

   With 2.9 in the SMS settings menu.  



4.5 Phone Setting  

  With 3.3 in the call settings menu.  

4.6 Data Account  

  4.6.1 GSM Data: For GSM data, editorial content is as follows:  

1, Account name: the account name, select Edit to modify.  

2, number: the account number.  

3, the user name: dial-up server (not the WAP gateway) account name.  

4, Password: dial-up server (not the WAP gateway) password.  

5, line type: Select the line type, analog or digital.  

6, Speed: Select the appropriate transmission speed.  

7, the primary DNS address: Enter the primary DNS address.  

8, Sub-DNS Address: Enter the second DNS addresses.  

4.6.2 GPRS: right GPRS editorial reads as follows:  

1, Account name: the account name, select Edit to modify.  

2, GPRS connection point: Enter the APN (Access Point Name that "access point name).  

3, the user name: dial-up server (not the WAP gateway) account name.  

4, Password: dial-up server (not the WAP gateway) password.  

5, authentication type: choose a general or encrypted.  

6, the primary DNS address: Enter the primary DNS address.  

7, Sub-DNS Address: Enter the second DNS addresses.  

4.7 Wallpaper  

   Choose wallpaper standby interface.  

4.8 LCD backlight  

With 4.3.14.  

4.9 Music Settings  

4.9.1 Play Set:  

1, repeat: Open the repeat play songs.  

2, random: Turn on the playing randomly.  

3, the background play: Open the the music does not stop with the withdrawal of the menu.  

4.9.2 Audio settings:  

1, sound effects: Set audio playback devices are horizontal, echo sound, stereo surround sound effects, 

sound effects turned on or off functions.  

2, bass enhancement: Turn on or off the bass enhancements.  

3, playback speed: Set playback speed: normal, fast, fastest, slow, slowest.  

4.9.3 Bluetooth Settings:  

1, Bluetooth stereo output: Turns on and off the Bluetooth stereo headphone output.  

2, Bluetooth Stereo Headset: Select audio services need to be connected into the Bluetooth stereo 

headphones. (For support of Stereo  

The Bluetooth headset when you want to turn this feature songs)  

4.10 Network Settings  

4.10.1 Network options:  

1, re-search  

2, select the network  

3, select the mode  



Automatic: Automatic search for the SIM card belongs network.  

Manual: Search is now available to all networks, manual registration.  

4, preferences settings: pre-existing number of your favorite network.  

4.10.2 Priority mode:  

Can be set to use only mobile phone system, only using a wireless local area network, mobile phone 

systems give priority to, wireless local area network priority.  

4.11 Security Settings  

4.11.1 Security Settings  

Showing SIM card and SIM card security settings for a security settings 2.  

1, SIM card lock:  

In this menu you can set the phone security options in order to avoid cell phone or SIM card is the illegal 

use. PIN code of your SIM card to prevent unauthorized use, if the current PIN is closed, select Open to 

open the PIN code protection, the next boot will ask you PIN code; if the current PIN code is already open, 

choose Close to close the PIN code protection, choose to change the PIN code you can set a new PIN 

code, please follow the prompts to enter the old PIN code followed by the new PIN code and repeat the 

new PIN code.  

 Note: PIN code three times, if⇔ mismatched, SIM card will be locked, when you need PUK code to 

unlock the SIM card. PIN code and PUK code may be provided with the SIM card to you, if not, contact 

your network vendor. The default PIN code is usually 1234, please change it as soon as possible to set 

their own password.  

2, fixed dial-up:  

When this feature is turned on, only a fixed dial-up tables can call the phone number or a few figures in 

the table at the beginning of the phone (requires SIM card support).  

Mode: on or off the fixed dialing function (required to enter the PIN2 code).  

Fixed Dial list: Enter the fixed-dial phone number.  

 Note: Turn on or off fixed⇔ dialing function, requires you to enter the PIN2 code, contact your network 

vendor to obtain PIN2 code, open the regular dial-up, go to the phone book shows a fixed dial in number.  

3, to prohibit dialing: This feature requires SIM card support.  

4, change your password:  

Change your password. Including the PIN, PIN2  

4.11.2 Phone Lock:  

In order to prevent the illegal use, your phone can set the phone password protected. Elected to use this 

feature, you each  

Second boot, you must enter the phone password, so you can unlock the phone, and then send or 

receive calls. Users can eliminate phone password, in this case, the phone will not prevent illegal use. 

Enter the phone password, clear the input error to use the right soft key, press to confirm the end. For 

example, if the phone password is set to 1122, then make the following type: 1122.  

 Note: The default phone lock⇔ password is 1122, you should change it as soon as possible for their 

own password. If you forget your cell phone password, you must contact your retailer or local authorized 

repair service center contact in order to unlock your phone password.  

4.11.3 Keyboard lock:  

Set the keyboard lock waiting time. After setting, when the phone is not used within a specified period of 

time, the keyboard will automatically lock. Standby mode press the # key to unlock.  

4.11.4 Change Password: password of the phone changes.  



* Note: Some features require support for your network operator.  

4.11.5 Certificate Management: View authorization certificates and user certificates.  

4.12 External links  

Need to connect external devices are: Bluetooth connection, connection management, data accounts.  

Bluetooth connection: Same as 15.  

Connection management: with 17.  

Data account: Same as 4.7.  

4.13 Restore factory settings  

Function to set the phone back to factory defaults, the password default value is: "1122."  

4.14 Sound  

Set audio playback devices are horizontal, echo sound, stereo sound effect ring Yang, turned on or off 

bass enhancements.  

4.15 Sensor Set  

When the sensor is turned around shaking the phone to switch songs, and calls to achieve the next turn 

when you switch cell phone ringing tone for the mute function.  

1, MP3 sensor settings: on or off MP3 sensors.  

2, call sensor settings: on or off call sensors.  

5. Book  

5.1 Open the e-book  

Open the e-book file.  

5.2 Update  

   Update e-bookcase.  

5.3 System Settings  

5.3.1 Font size: select large, medium and small fonts on the 3rd.  

5.3.2 Volume page: Select line scrolling and page scrolling.  

5.3.3 Auto scroll: on or off auto-scrolling.  

5.3.4 scrolling speed: Select the auto-scrolling speed.  

5.3.5 Full-screen: Turn on or off full-screen reading.  

5.3.6 encoding: Set the e-book reading of the encoding. The default is: English (Windows).  

* Note: Open the e-book when the encoding, needs and encoding of the file consistent with the way 

e-books, or e-book content is not displayed correctly.  

5.3.7 Alignment: Alternative left-justified, right-aligned.  

 5.3.8 Select storage location: Choose the path to read e-books, memory card or mobile phone.  

5.4 Information  

  View e-book format, size and other information.  

5.5 Delete  

Delete the e-book file.  

5.6 Delete all files  

Remove the list of all the e-book file.  

5.7 Sort by  

 Choose by name, type, time, size of the sort.  

5.8 implementation of the System Settings  

To restore the default settings.  

5.9 Help  



Displays help information.  

6 Network Services  

6.1STK  

This item is provided by the network provider. If the SIM card and network providers do not support the 

kinds of services, the functions will not be used. For more information, please contact with the network 

provider.  

6.2 Internet Service  

6.2.1 Menu function:  

1, Home page: Log Home. Home page is your connection settings in the start set the WAP site. If you do 

not set, will use pre-set vendor sites.  

2, bookmark: Show all existing bookmarks. Choice can be directly connected to the bookmark URL. 

Select the option to enter the following menu:  

Enter: Link to the current bookmark URL.  

Edit: Edit the current bookmark name and URL.  

Send: the bookmark URL via SMS, MMS, e-mail sent.  

Delete: Delete the current bookmark.  

Delete All: Delete all the bookmarks list.  

Add a new bookmark: edit the title and address information.  

3, web history: The records you have previously viewed online by the web site.  

4, has maintained website: displays a list of stored pages.  

5, enter the URL: Select this you can enter any of a WAP or any other Internet sites.  

6, Service inbox: receive the WAP PUSH message mailbox.  

6.2.2 settings: settings for Internet browsing.  

1, select the SIM card: can be set to Always ask, SIM card 1, SIM card 2.  

2, edit the settings file: Select settings for the service group, there are eight set group to choose from. 

Choose a setting to the next one to set the menu to view the file information, as well as startup settings 

file.  

3, browse options: browsing the web when the parameter settings. Including wait time and display 

pictures.  

4, service information is set: to open or close the service information.  

5, clear the cache: Select the Clear Cache.  

6, clear the cookies: Select this item to remove personal data.  

7, trust certificate: You can browse and select the trusted certificate.  

* Note 1: GPRS network support service needs to be opened later and the GPRS network coverage in 

areas, in order to use GPRS services.  

* Note 1: The system software of Netease, Baidu, google, Sina, Sohu, Yahoo and other menu, login 

features and functions the same as in this note.  

6.3 Baidu search  

    Need to search the contents of the input, select the search that is into the web search the contents of 

the specific menu functions with 6.2.  

6.4UCWEB browser  

Your phone provides you with a UC browser, you can use the UC web browser. This feature requires 

network support. First entry into the browser, the system will automatically get initialization data to 

initialize.  



In the UC browser interface to select menu items to enter the following menu:  

6.4.1, open the  

To open the home page, URL, bookmark, and Help menu.  

1, Home Page: enter the home.  

2, URL: enter the URL editing interface for editing site, editing, press OK to complete connection URL.  

3, bookmark: Entering bookmark list select collection of bookmarks browsing. Select a menu item to 

enter the following menu:  

4, to determine: a bookmark to connect to the current Web site;  

5, mobile: You can select the bookmark to move to the top, bottom, top or one that already exists  

The directory.  

6, Editor: edit the bookmark name into the editing interface, click OK to enter the path after the editing 

interface to edit the bookmark path, press OK to finish editing.  

7, New: Can a new directory, the new label, selection into the editing interface for editing the directory 

name press OK to complete the new directory, edit the label name and press OK to enter the path editing 

interface, click OK to finish editing the completion of the new label.  

8, delete: delete the current menu, choose to delete the selected bookmark, choose to delete all 

bookmarks menu to delete the list of all bookmarks.  

9 Help: Display UcWeb6 details.  

6.4.2, navigation  

Includes forward, backward, refresh, the Favorites menu.  

1, forward: When you select Back to return on a website, select the advance might return to the current 

page.  

2, Back: return to the previous one website.  

3, Refresh: Refresh the current page.  

4, Collection: Save the current URL to the list of bookmarks.  

6.4.3, the window: You can browse two windows, through the New Window menu to open a new window; 

a new window to open the menu and open a new focal point of a link; choose Window menu to switch to 

achieve switching between the two windows, select the Close Window menu Close the current window.  

6.4.4, tools:  

1, Save Target As: save the currently selected message, the default storage location for the memory card. 

Is saved in File Manager menu to view store information.  

2, download management: access to download the list of tasks, menu under the following menu: Select 

the pause menu to suspend the current download to download the task; choose to download the menu 

continues to be suspended to download the task; choice can re-download the menu has been suspended 

or have been completed Download the task to re-download; the task menu displays the current task more 

detailed information; delete the current: Delete the current download tasks; removal is complete: Remove 

the download has completed the task; Exit management: Quit Download Manager menu.  

3, the page attributes: display the current page path, select the menu item to open the path into the 

current editing interface, the path can be edited; select View to view the current path.  

4, Clear: choose Clear history, cache, and fully realized historical information, cache information, all the 

information removed.  

6.4.5, set: There are menus,  

1, theme settings: Set your browser's theme elements available with either black, pink, night three 

models.  



2, the system set up: You can set up networks and systems, respectively detailed information under the 

menu option to restore the default option, the system default network access point for: china mobile gprs, 

network access proxy way: agent (ask your operator to confirm whether the GPRS service has been 

opened); when the network access point is set to: wireless local area network, please set the network 

access to: Direct Connect (make sure there are available wireless local area network).  

3, horizontal screen switch: You can switch the screen display horizontal or vertical display.  

4, full-screen switch: You can switch to the browser interface, full screen.  

7. Multimedia  

Your mobile phone to provide you with a variety of third-party software (video chat, mobile TV U m, U m 

Internet radio, FLV partners), in order to provide you with better quality TV, Radio and video chat. Note: 

Some features require network support, the specific flow rate and tariff information, please consult your 

operator.  

7.1 video chat  

Specific operating instructions refer to the software interface.  

7.2 Camera  

Your phone offers camera features, select the menu entry of the camera, press OK key to take pictures.  

Options include:  

7.2.1 Album: into the album.  

7.2.2 Camera Settings: When I am photographing a number of related parameters settings.  

7.2.3 Photo Settings: Photo size and photo quality settings.  

7.2.4 White Balance: But when the light settings.  

7.2.5 Preset Modes: Choose Auto or night shooting mode.  

7.2.6 Effects settings: effects of different models of selected photos.  

7.2.7 Storage Location: Set the default storage path for photographs.  

7.2.8 Restore Default: Set to restore the factory default values.  

7.3 Album  

View photos stored in folders under the photos or pictures.  

7.3.1 View: Zoom preview the selected photos.  

7.3.2 Printing: Connect the network printer to print pictures.  

7.3.3 View Mode: Change album photo view mode select "matrix" or "list" mode.  

7.3.4 Send: Through MMS, e-mail, Bluetooth, a way to send photos.  

7.3.5 for: the use of selected photos as wallpaper, switch machine animation.  

7.3.6 Rename: Change the selected photo file name.  

7.3.7 Delete: delete the selected photos.  

7.3.8 Sort by: According to the piece name, type, time, or the size of the selected folder of photos to sort.  

7.3.9 Delete all files: Remove all of the photos album.  

7.3.10 Storage Location: Change and choice of reading and take photographs of the storage path.  

7.4 Video Recording device  

Your phone offers recording animated features, video recording device select menu entry, click the 

button for video recording.  

Press Options to enter:  

7.4.1 Video Settings: Select this menu, enter the recording device of some relevant parameters settings.  

7.4.2 Video Settings: Video quality parameter settings.  

7.4.3 White Balance: video-light settings.  



7.4.4 Effects settings: you can choose your video of this one special effects.  

7.4.2 Storage Location: Select stored in phone or memory card.  

7.4.3 Restore Default value: all the settings to their factory default values. 

 

7.5 Video Player 

Play users have stored on film, to select the shortcut keys associated interface operations, the following 

functions: 

7.5.1 Play: play the selected animation. 

7.5.2, send: Through MMS, send e-mail and Bluetooth. 

7.5.3, rename: change the file name of the selected animation. 

7.5.4, delete: Delete the selected animation. 

7.5.5, delete all the files: remove all save the animation. 

7.5.6, Sort by: For the current folder in the animation sort by name, type, time, large 

Little or none. 

7.5.7, storage location: Choose to read the file path, mobile phone or memory card. 

7.6 music player 

Select music player into the MP3 player interface, optional interface shortcut keys in the related 

operations. 

Click the upper right corner of the icon into the album playlists, songs, after loading you can scroll search 

songs for playback. 

Song list interface, and then point the left soft-option into the song some of the health-related settings. 

7.6.1. The basic functions of 

1, Play: Play the currently selected songs. 

2, detailed information: see the song details. 

3, Move: Move the cursor to the selected songs on a song. 

4, down: Move the cursor to the selected song to the next song. 

5, add: From the phone or memory card, select songs to the playlist. 

6, remove: remove the selected songs. 

7, send: Through MMS, send e-mail and Bluetooth. 

8, for: to join the current profile song ringtones library. 

7.6.2 Music Set 

    Music settings with the 4.9. 

7.7 Recording 

Select this item can be recorded, click on the shortcut keys associated interface operations. Press the left 

soft-Jian entry options: 

7.7.1, a new recording: record a new voice. 

7.7.2 Play: Play the currently selected recording. 

7.7.3, added: on the basis of the original recording and add new recordings. (For AMR, AWB format) 

7.7.4, rename: change the name for the current audio file. 

7.7.5, delete: delete the current recording file. 

7.7.6, the list: Check out audio file list. 

7.7.7, set: Set record repository, the file format and sound quality. 

7.7.8 for: the current recording sent to the scene mode ringtones library. 

7.7.9, send: current recording via MMS, e-mail, Bluetooth sent. 



7.8 FM 

Your phone supports FM radio, you can click on the shortcut keys associated interface operations. Select 

"Options" button, proceed as follows: 

7.8.1. Channel list: You can edit the channel name, frequency. Appear on this list; 

7.8.2. Manual Input: Direct Input FM radio frequency, such as: 103.7; 

7.8.3. Auto Search: Auto Search FM channel and automatically update the channel list; 

7.8.4. Settings: Set the background player turned on or off, set the appearance style. 

Slide 7.9 

This paragraph phone supports slide show function, can select a folder that contains images to set into a 

slide file. 

7.9.1. Play: Play the slide. 

7.9.2. Setting: You can set up slide shows the relevant parameters: 

1, Play mode: automatic (once), auto (repetition), Manual. 

2, speed: slow, medium and fast. 

3, Effects: No effects, progressive, segmentation, random. 

4, the background music: choose to close or from a file selection. 

5, the level of play: Turn on or off the level of playback functions, 

6, sound: off, music 1, music 2, music 3. 

7, Sort by: by name, by type, depending on the time, depending on size, or no sort. 

7.10.3. Continue: to continue to slide. 

7.10 TV 

Analog TV playback, you can manually or automatically search to get the channel. 

Note: This function must select the area corresponding to the channel format, and can be obtained by 

adjusting the antenna for better TV signal. 

7.10.1 Add to my channel: Custom channel option, and can be its own common or preferred channel, 

save it to my list of channels to facilitate the playback channels. 

7.10.2 Channel list: saved searches to the TV channel list. 

7.10.3 My Channel: Save your favorite television channel list. 

7.10 .. 4 Channel Search: Auto search station function, through all channels, the signal channel is saved 

to the list. For select Play. 

7.10.5 Search area: to provide the various regions of the format options. 

7.10.6 display settings: 

1, Brightness: adjust the brightness when on television. 

2, the signal strength display: You can choose to open or close the weak TV signals when prompted. 

3, the signal weak Tip: to open or close the weak signals prompt. 

 

8. Toolbox 

8.1 Calendar 

Access to the calendar management submenu. 

Press Options to enter sub-menu 

Create a new schedule is displayed as: conferences, courses and other matters. And have worked to add 

an alarm reminder. You can choose to once, daily, self-definition, weekly, monthly five options. 

Once again: that the schedule is only to remind once. 

Every day: that day, at all times in the set will remind. 



Self-definition: set the alarm sounded in the week time. 

Weekly: that the set time every week will be reminded. 

Monthly:: said at a set time every month will be reminded. 

1, view: view the current calendar date. 

2, View all: View all schedules. 

3, Add Event: Add schedule 

4, delete events: remove unwanted events. 

5, go to the specified date: The calendar of the current date is set to the specified date. 

6 to Week / Month View: View a month or a week schedule. 

7, Lunar New Year: on or off Lunar New Year show. 

* Note: Due to storage space is limited, please user the best record store no more than 70. Otherwise be 

lost. 

8.2 task 

The list in the task to add appointments, telephone, anniversaries and other memo information. 

8.2.1 Add 

1, Date: memorandum prompt date. 

2, time: memorandum prompt time. 

3, topic: prompt displayed on the screen content. 

4, alarm clock: alarm clock on or off. 

As follows: 

Once again: that the memorandum is only to remind once. 

Every day: that day, at all times in the set will remind. 

Self-definition: set the alarm sounded in the week time. 

Weekly: just to remind once a week, said the memorandum. 

Monthly: reminder once a month, said the memorandum. 

5, location: Editor Memo location information displayed on the screen when prompted. 

6, priority: Set the memo priority: high, medium and low. 

7 Details: Edit the task details. 

8.2.2 View: View of the memorandum has been saved. 

8.2.3 Add: re-add the editor to another memo. 

8.2.4 Editor: re-edit the saved aide-memoire. 

8.2.5 Delete: Delete a single memo has been selected. 

8.2.6 Delete expired tasks: (when the task list will be displayed when there is overdue reminder of the 

menu) to delete the reminder has expired. 

8.2.7 Delete All: Delete all saved aide-memoire. 

8.2.19 jump to the specified date: jump to the specified date of the memo list. 

8.2.9 send the schedule: The selected memo via SMS, MMS, e-mail sent to other Bluetooth-enabled 

hand - 

Machine. 

8.2.10 saved as File: Save to local file management. 

 

8.3 Alarm 

8.3.1 Switch: Turn on and off the alarm clock. 

8.3.2 Time: set the ringing time. 



8.3.3 Ringing mode: 

1, once again: indicates that the alarm clock just to remind once. 

2 a day: that day, at all times in the set will remind. 

8.3.4, self-definition: set the alarm clock ringing in the week time. 

8.3.5 Ring Settings: Set ring tones or FM radio. 

8.3.7 Snooze Time: Set 1 ~ 10 minutes, or the default value, the alarm time septal tips. 

8.3.19 Ring mode: Set ringing, vibration, vibration and ringing. 

8.4 World Time 

You can set the world time. 

9. Profile 

9.1 Standard Mode 

9.1.1 Start: Select the boot into standard mode. 

9.1.2 Personal settings: Select your personal settings to enter the mode to customize it. 

Functions as follows: 

1, ring tones settings: change the call, switch machines, information, and key tone type of sound and so 

on. 

2, volume: adjust sound volume of ring tones and keypad tones. 

3, suggesting that type: Select a prompt type: ringing, vibration, vibration and ringing, vibrating ring post. 

4, bell type: heard, repeated or crescendo. 

5, suggesting that tone: set the tone of certain events: a warning, error, network connections or calls with 

sound 

Access and so on. 

6, response mode: Set any key answer. 

9.2 Meeting mode: 

With the standard mode of operation 

9.3 Outdoor Mode 

Operation with the standard model. 

9.4 Indoor Model 

Operation with the standard model. 

9.5 Headset Mode 

Plug in headphones, the phone automatically defaults to the headset mode, specific operations with the 

standard model. 

9.6 Bluetooth Mode 

After the success of the Bluetooth headset to connect the phone automatically defaults to the Bluetooth 

mode, specific operations with the standard model. 

 

10. Exchange rate conversion 

Any change in currency exchange rates between the conversion. Input rate, and then enter the national 

or foreign currency values, press the left soft key OK, in another edit box displays the values you need. 

11. Document Management 

11.1 use function 

Open: Displays the contents of the folder. 

New Folder: In this folder create a new information. 

Format: Format the folder. 



Rename: change the file or folder name. 

Delete: delete the file or folder. 

Sort by: The file or folder to be sorted. 

Details: view a file or folder details. 

Copy the files: Copy the file or folder to any location. 

Moving Files: Move the file or folder to any location. 

11.2 Folders feature 

Audio: The default save path of record. 

Images: Photo of the default save path. 

My Music: store folder upload songs, music player, the default path. 

Photos: photographs of the default save. 

Videos: shooting video of the default save. 

 

12. Calculator 

Click Enter to calculate the number of 0-9. 

Click the appropriate symbol can enter ,-,*,/, M, M-, MC, MR a total of eight operational symbol. 

Click to clear the last bit can be input or results, click the "Back" opt-out calculator, click the "OK" 

calculations. 

* Note: This computer device has limited accuracy and rounding errors will be generated, especially in 

the divisible time. 

13. Stopwatch 

The machine-oriented sub-general and multi-stopwatch stopwatch, this feature can accurately recording 

time, click OK, enter the Options menu: 

13.1 General code table 

   Namely, two kinds of timing and in lap time. Time can be kept in view the record time to view, delete or 

delete all. 

13.2 Multi-oriented code table 

    Click around and down time can be recorded separately, after a pause can be cleared by reset. 

14 Telephone 

Click to dial into the phone menu interface 

14.1 phone features 

14.1.1 Use the numeric keys to call: 

1, click on the main menu of the dial-up menus, in the dial interface, click the digital input telephone 

number, to repair 

To change the number on the screen, move the cursor, and then a short click the Clear icon to delete a 

character before the cursor, long click the Clear icon to clear all the characters. 

2, enter the dial phone number, click to dial, can be dial-up card 1 or card 2. 

3, click on different icons, can enter the number to save, call records, call center, phone book and voice 

mail menu. 

14.1.2 to use the telephone book to call: 

Into the telephone book list, select the desired number, enter the option, and select Call. 

14.1.3 the use of phone records to call: 

Access to call records, select the desired number, enter the option, and select Call. 

14.2 Call Options 



Used in a variety of call features. 

Mute: Turn off the microphone, so that the other party can not hear their own voice. 

Dial pad: Open the dial pad, you can enter a number. 

Hands-free: Open speaker, the sound from the speakers in the issue. 

Add a call: You can enter numbers, create a new call (this feature requires the network operator support). 

Reservations: call to suspend. 

Phone book: You can enter the phonebook menu. 

15. Bluetooth 

The phone supports Bluetooth technology, support for headset mode, text mode of transmission patterns 

varied. 

15.1 Bluetooth Settings menu 

15.1.1 Activate Bluetooth: on / off the Bluetooth function 

15.1.2 Search for hands-free devices: search the current Bluetooth hands-free devices 

15.1.3 Remote control: via Bluetooth can control the computer desktop, slideshow, music player and so 

on. 

15.1.4 My devices: has been seized and the establishment of the connection device list. 

15.1.5 Connect the device: the current established connection equipment. 

15.1.6 Setting: When using the Bluetooth function, you first need to do the necessary settings. 

15.1.7 my Bluetooth: Bluetooth view the current situation. 

15.2 to establish a Bluetooth connection 

    Bluetooth opens, select "Search-free device", or go to "My devices" - "Options" - "Search new device" 

to search for Bluetooth devices within the valid range. The importation of equipment identified in 

consultation with the Bluetooth password in order to create the pairing between devices, then you can 

transfer data. 

After the Bluetooth connection device connected devices can do the following: 

Online: Get connected device in the device name. 

Delete: Delete all devices in the list records. 

Service Records: to view the current can be of service. 

Search for new devices: See Bluetooth device within a valid range. 

Using Bluetooth technology to mobile phones within 15 meters with a compatible Bluetooth device to 

establish an unlimited connection. However, the Bluetooth wireless connection may be due to 

obstructions such as walls or other electronic equipment from interference. 

Bluetooth wireless technology using the required functionality, or use other features to run in the 

background of these features, it will quickly consume phone battery power and shorten battery life. Do 

not recommend the Bluetooth technology off the feature. 

To ensure mobile phones and other wireless technologies to support each other between the operation 

of the equipment, please use our equipment manufacturer recognized as applicable to this model phone 

accessories, on equipment manufacturers to determine whether their equipment is compatible with this 

phone. 

 

16. Fun & Games 

Your mobile phone to provide you with a variety of third-party entertainment software (U m game centers, 

excellent m sensual listening to the book, JAVA, JAVA settings): 

16.1 Um game center 



The game need to network and memory card support, the specific instructions detailed in the software 

help explain the menu. 

16.2 Um sensual listening to the book 

The software requires network support, for the first time will need to download and install the software 

directory, the software prompts the light of specific operations. 

16.3 Java 

Choose Opera Mini 4.2 can enter the following menu interface: 

(Note: This feature requires network support, tariffs please consult your operator for the first time using 

the need to install the application software.) 

Executive: Select this menu and entered the web interface. 

Setting: You can set up the network access, self-executing, information, multimedia, reading the user 

data, write the user information, the local on-line manner is always asking permission, do not allow for 

each question, the first question, only ask once. 

Details: Display game software for more information. 

Network: 

Set mode: can be set to the default value JAVA or user-defined, when the mode is set to the default value 

of JAVA to use the default value of the following menu: Select the SIM card, Java SIM card settings 

group. 

Select SIM card: SIM card can choose one or the SIM card 2. 

Java SIM card a set group, Java SIM card is set Group 2: 1 respectively for the SIM card and SIM card 2 

set the appropriate network connection. 

To restore the default settings: Select this option to restore default settings. 

16.4Java Set 

Java Sound: Set the sound size, there are seven levels to choose from. 

Java backlight: backlight on or off. 

Java vibration: vibration on or off. 

SIM card options: select the desired SIM card to SIM card 1 or SIM card 2. 

JAVA SIM card settings Group: setting need to use the network. 

Implementation of the memory size: Set a value of 2.048 million bytes. 

16.5 Games 

Mahjong: 

New Game: start a game. 

Game Mode: Select the game difficulty. 

Best Ranking: This game record list. 

Game Help: to enter the menu to see rules of the game. 

Game Setting 

Background Sound: Turn on or off the game background music. 

Sound: Turn on or off the game sound effects. 

Game vibration: vibration on or off the game tips. 

Volume: adjust the volume size. 

16.6 Dynamic Games 

Dynamic Dice: 

Start: Start a game. 

Game Setting: Event, sound, volume and other settings. 



Event Settings: Add Event. 

Help: to enter the menu to see rules of the game. 

17. Wireless Network 

1, enable wireless networks: enable and disable the wireless network. 

2, wireless network status: Displays the wireless network status information. Such as: mobile phone MAC 

address, SSID, BSSID, channel, signal strength, speed, IP address. 

3, the access point settings: enter the access point list, when the list is empty, select Options to enter the 

access point editing interface, when the list is not empty when you select the option to enter the following 

menu: 

Connection: connect or disconnect the connection with the APN 

Editor: enter the Edit menu to edit the current access point, as follows: 

The link name: set the link name. 

SSID: Set Service Set ID. 

Set Network Type: Infrastructure construction, point to point wireless transmission. 

TCP / IP settings: Set whether to use DHCP, set the IP address, set the subnet mask, set the default 

gateway, set the primary DNS address, set the second DNS address. 

Set the security mode: Open network, sharing, IEEE 802.1X, WPA / WPA 2, WPA / WPA 2 PSK. 

Encryption mode: Set encryption mode is turned off or WEP. 

WEP key settings: (when WEP encryption mode is set to when you need to set the WEP key) 

Set in the use of WEP keys: can be set to # 1, # 2, # 3, # 4. 

WEP Encryption: can be set to 64-bit or 128-bit. 

WEP key format: can be set to ASCII or hexadecimal. 

WEP key: enter the editing interface for editing keys. 

New access point: New and edit the access point. 

Delete: delete the access point. 

Change Priority: set the access point priority. 

4, the search network: search for available wireless networks. 

Connection: connect or disconnect the wireless network. 

The definition of access point: the definition of the type of network access point and settings. 

Details: Display the access point network status and other information. 

Update: refresh the list of available wireless networks. 

18 calls Background Music 

Can be set to the background sound when making a call. 

18.1 choose to call 

When you call to set the background sound on or off. 

18.2 Play Set 

Set the background tone of the volume, play mode. 

18.3 Background Music List 

There are 10 kinds of background sounds to choose from. 

19 MSN 

Your mobile phone to provide you with MSN chat software, the software needs of network and memory 

card support. 

19.1.1 Start: 

For the first time will need to download the software, the software have been downloaded into the 



sub-menu to select the MSN menu to enter 

To the login screen, enter the account name and password, right-click login. Enter the login account 

interface, click Options menu 

Enter the following menu: 

1, log on: the current account login. 

2, registration: enter the registration interface, enter the account number, password, press OK to send 

registration request. 

3, log settings: can be set to save passwords so as to avoid the trouble of each log type can also set up 

automatic logon. 

4, the connection settings: can be set to WAP connection, NET connection, WIFI. 

More software instructions please refer to logon screen list of options under the Help menu. 

19.1.2 Settings: 

Update frequency can be set once a week once a month, or temporarily update; can set up the network 

connection WAP 

Connection, NET connection, WIFI. 

19.1.3, version upgrade: update software version. 

19.1.4, on: release notes. 

More tariff instructions, operating instructions, download the monthly flow of information, please refer to 

the software provided by the user help area (update the software before it can view it)                   

20 Art font 

   Three of the font for you to choose: Simple bold, amber body, Mao Zedong fonts, font selection will be 

the interface corresponding font, the system default is simple blackbody. 

Frequently Asked Questions 

Network operator can set the feature does not support or need to sign up, please contact the network 

transport 

Business Contacts 
PIN has been locked input network operators to provide, together with the SIM card PUK code to unlock 

the password, or contact your network operator. 
PIN2 locked enter the network operator with the SIM card provided with the password or contact PUK2 

code to unlock network operators. 
Hua Fei did not transfer billing pulse counter is invalid, please contact your network operator. 
SIM card SIM card error dirty, clean and SIM card 
To re-install the SIM card 
SIM card has been damaged, replace the SIM card. 

The manufacturer has the final interpretation of this manual. 
The manufacturer reserves the technical rules change without prior notice. 
The manufacturer reserves the right to modify this manual without notice. 
The manufacturer reserves without prior notice for technical product specifications, under 
the right to make changes. 
 
 





 


